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1 Introduction
This document aims to provide instructions on setting up Fitting and HIT Units as well as
installing and con figuring the Primus software. It also includes essential information on safety
measures, maintenance, and calibration.

The Fitting Unit is a general term combining PFU, PFU+, Primus Pro, and Primus Ice hardware
units. Please refer to the Abbreviations and Terms section for definitions of these units.

Depending on your purchased licenses, some of the modules described in this document might
not be available in your version of Primus software. Please contact your distributor to get more
information on the licenses.

This document is not intended to be a complete reference. For detailed information, please
refer to the Help file after installing the Primus software.

2 Abbreviations and Terms
Term Definition

PFU
PFU stands for Primus Fitting Unit. This includes PFU, PFU+, and Primus
Pro hardware units. These units are used to perform pure tone and speech meas-
urements as well as REM and SM measurements.

Primus
Ice 

Primus Ice is the name for Primus Audiometer Unit. This unit is used to perform
pure tone and speech measurements only.

HIT HIT stands for Hearing Instrument Test chamber.

AUD Audiometry.

REM Real Ear Measurements.

SM Speech Mapping.

HTL Hearing Threshold Level. Establishes the minimum level at which the client can
detect the presence of a pure tone signal 50% of the time it is presented.
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3 Symbols Used
The following symbols are used in this document and/or on labelling on the device.

Labels on Fitting Unit and HIT Unit

Manufacturing date

Manufacturer name and address

Disposal instructions

Non-ionising radiation

Serial Number

Reference Number

Labels only on Fitting Unit

Type B applied parts.
Patient applied parts that are not conductive and can be
immediately released from the patient.

Class II equipment

Non-reusable (disposable parts)

Follow operating instructions

Operating instructions

General warnings

CE - notified body
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Labels only on HIT Unit

Caution, please read the Instructions for Use and the User
Manual

CE
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4 Compliance with Standards
Classification according Annex IX of EU Medical Device Directive (MDD) 93/42/EEC:

Device Class Rule CE

Primus Fitting Unit (all variants) IIa 10 CE0123

Primus Audiometry Unit (Ice) IIa 10 CE0123

Primus HIT Pro I 12 CE

Classification according Annex VIII of EU Medical Device Regulation MDR (EU) 2017/745:

Device Class Rule CE

Primus Fitting Unit (all variants) IIa 10 CE0123

Primus Audiometry Unit (Ice) IIa 10 CE0123

Primus HIT Pro I 13 CE

All Auditdata devices covered in this manual, including the listed accessories and respective
applied parts, comply with the Council Directive RoHS-II/2011/65/EU.

The Fitting System complies with the following standards:

Safety:

l IEC 60601-1/A1:2012, class 2, type B
l IEC 61010-1:2010 for HIT Unit

EMC:

l IEC 60601-1-2:2014

Audiometry:

l Tone: IEC 60645-1:2017 / ANSI S3.6:2010 Type 1
l Speech: IEC 60645-1:2017 / ANSI S3.6:2010 Type A or A-E

Real Ear Measurement:

l IEC 61669:2015 and part of ANSI S3.46:2013

Hearing Instrument Testing:

l IEC 60118-7:2005
l IEC 60118-15:2012
l ANSI S3.22:2009
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5 Intended Use/Indications for Use
The Fitting Unit is intended for use by professionals such as an audiologist, hearing healthcare
specialist, or trained clinicians. The devices must only be used for their intended purpose as
stated in this document below.

Audiometric testing should take place in a sound treated quiet environment and care should be
taken to ensure optimal test conditions and safety of the client during testing.

PFU and Primus Ice

l The PFU/Primus Ice is intended for performing hearing tests.
l The PFU/Primus Ice with stated accessories is indicated for non-continuous, noninvasive

air and optionally bone conduction and speech audiometric testing in quiet office and
sound treated environments.

l The PFU/Primus Ice is indicated for use with both paediatric and adult age groups.
l The PFU/Primus Ice is not indicated as a sole means of diagnostics.

PFU Only

l The PFU is indicated for non-continuous real-ear measurements at the ear drum by
means of noninvasive external ear canal insertion of a probe tube in quiet office
environments.

l Finally, the PFU can be used to present hearing instrument related sound examples
through headsets or loudspeakers.

HIT

l The Hearing Instrument Test Unit is intended for use by professionals such as an
audiologist, hearing healthcare specialist, or trained technician.

l Hearing Instrument testing should take place in sound treated quiet environment and
care should be taken to ensure optimal test conditions and safety of the client during
testing.

l The Hearing Instrument Test Unit is intended to give an objective indication of the
characteristics of a Hearing Aid, by visualizing a signal recorded in the test coupler with
reference information such as target curves in order to make adjustments of the Hearing
Instrument settings.

l The Hearing Instrument Test Unit is indicated for technical quality inspection of hearing
instruments with no clients involved.
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6 Safety Instructions
PLEASE READ THE SAFETY INFORMATION COMPLETELY BEFORE USING THE FITTING

SYSTEM!

6.1 Applied parts
l The headsets / patient switch are only to be used with uninjured skin of the test person.

The time of usage is short duration and less than 24 hours.
l Parts that come into contact with the client (that is, transducers, the handheld push-

button, and the probe microphone set) should be disinfected before use.

6.2 Fitting Unit
l Parts such as foam tips on insert earphones or probe tubes for real-ear measurement are

not intended for reuse. Dispose of such items in a hygienic manner after each client
session.

l Do not use talk forward microphone in areas where there is risk of acoustical feedback.
l The headphones supplied must not be used with any other branded equipment.

Headphones from other branded equipment must not be used with the system.
l Connect only such headphones and other external devices that are approved for

connection to the System.
l Probe tube measurements must be performed by trained professionals only.
l Avoid exposing the client or other persons to unnecessarily high sound pressures, as

these may be damaging to hearing.
l Before applying the headphones or insert phone, inspect the patient’s ear drum, ear

canal, pinna and surrounding areas for lesions or other types of infection. Do not use the
headphones or insert phones if any contraindications exist.

l Remove any barriers before placing the headphones or insert phones on the patient,
such as jewellery or the patient’s hair during the test.

l During real-ear measurements, carefully position the probe tube so as not to contact the
ear drum.

l Accessory equipment connected to the analog and digital interfaces must be in
compliance with the respective nationally harmonized IEC standards ( IEC 60950 for data
processing equipment, IEC 60065 for video equipment, IEC 61010-1 for laboratory
equipment and IEC 60601-1 3rd for medical equipment). Furthermore all configurations
shall comply with MEDICAL ELECTRICAL SYSTEM in IEC 60601-1 3rd.

l Everybody who connects additional equipment to the signal inputs/outputs configures a
MEDICAL ELECTRICAL SYSTEM, and is therefore responsible that the system complies
with the requirements of the standard IEC 60601-1 3rd. If in doubt, consult the technical
service department or your local representative.

l To comply with MEDICAL ELECTRICAL SYSTEM in IEC 60601-1 3rd the Audiometer,
equipment parts and ACCESSORY, except for specified Type B applied parts, must be
located outside PATIENT ENVIRONMENT, i.e. not closer than approx. 1.5 meters/5 ft.
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l The use of accessory equipment not complying with the equivalent safety requirements of
this equipment may lead to a reduced level of safety of the resulting system.
Consideration relating to the choice shall include:

l Use of the accessory in the PATIENT VICINITY.
l Evidence that the safety certification of the ACCESSORY has been performed.
l In accordance to the appropriate IEC 60601-1 3rd.

6.3 Fitting and HIT Units
6.3.1 Maintenance and Cleaning

l Do not modify the equipment without authorization of the manufacturer.
l Maintain a high level of hygiene and clean reusable devices which come into contact with

clients between each use. See the cleaning instructions below.
l For cleaning use only a soft dry cloth dampened very sparingly with a low level

disinfectant solution such as isopropyl alcohol to wipe the device. Do not allow excess
solution to enter the device as this may damage internal components.

l Do not use acetone or paraffin/kerosene-based solutions, or any other harsh solvent to
clean the device or its accessories. Use of such substances may be harmful to the
equipment and may result in faulty operation.

l The headphones, probe microphone set, cables, connectors and other electrical
accessories are not waterproof. See the Cleaning instructions for safe handling.

6.3.2 Usage

l The system with attached accessories is to be operated by qualified personnel only.
l The device is intended only as an adjunct in client assessment. It must be used in

conjunction with assessment of clinical indicators and symptoms.
l The main power supply should be easily accessible for plugging/unplugging.

l

If the PC complies with IEC 60950 or with IEC 60601-1 3rd, use the USB cord to
connect to the system. Do not touch the USB connector from the PC and the patient at
the same time, when a IEC 60950 approved PC is used.

l The device should be directly connected to the PC and not to a USB hub.
l Do not use defective equipment. If you suspect a malfunction, contact a service

representative authorized by manufacturer for inspection of the equipment.
l On a regular basis, that is, at least once a week, perform a visual inspection of the Fitting

and HIT Units and their accessories for visible damages. Do not use damaged
headphones or accessories with the device. During use, evaluate the test results and
perform a system inspection if the results appear unreliable.

l When using the device with insert phones or probe-tube set, note that the used foam ear
tips or probe tube should be disposed in a manner consistent with normal infection
control procedures.
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l In the event of irreparable damage to the device, dispose of it through an approved
hazardous materials disposal facility in accordance with the RoHS (Restriction of the Use
of Certain Hazardous Substances) and WEEE (Waste Electrical and Electronic Equipment)
regulations, or return it to manufacturer.

l Do not connect non-medical equipment unless it forms part of the medical system. There
is a danger that the leakage currents may exceed their valid limits and consequently be a
hazard to the client and the examiner.

l The devices should be contained in an environment according to the operational
specifications, so that the temperature and humidity does not rise above dangerous
measures. Refer to B.1 Technical Specification for allowed temperature, humidity, and air
pressure.

l Do not expose the device to moisture. Extreme moisture can cause the device to fail or
perform inaccurately.

l The devices must only be used for their intended purpose.
l All tests must be conducted in a sound treated or sound proof room with low ambient

noise.
l Excessive movements should be avoided during the test, as it may interfere with the

measurement and can result in wrong measurement results.
l The headset and transducers delivered with the Fitting System and reference and coupler

microphones delivered with the HIT Unit are NOT intended for calibration by users.
Contact your local distributor for your annual service and calibration.

l Do not pull the headphone cable. To disconnect the headphones or other accessories
from the device, pull the plug.

l The examiner should take care never to touch non-medical parts of the system and the
client at the same time.

l EXPLOSION HAZARD: Do not use the device in the presence of flammable substances.
l ELECTRIC SHOCK HAZARD: Do not attempt to disassemble the device. The device

contains no user-serviceable items inside.
l Carefully route all the cables to reduce the possibility of entanglement or strangulation.
l Fasten the Fitting Unit on a wall, under a table or place it on a stable surface. If

considered more practical, the Fitting System can also be placed inside the audiometric
booth or piggyback to the HIT unit. Place the HIT Unit on a stable surface.

l Do not place the system on or near equipment that generates a strong magnetic or
electrical field, as this may cause improper operation and interfere with the intended use
of the device.

l If mobile multi-outlet power strips for mains power supply are in use:
l they must comply with MEDICAL ELECTRICAL SYSTEM in IEC 60601-1 3rd
l their rated current must not be exceeded

l Cables should be changed by properly qualified personnel only.
l Any external equipment should be connected in such a way that the Fitting Unit with

connections still observes the safety requirements in IEC 60601-1 3rd.
l Conductors and wiring between the system components must be protected against

mechanical damage.
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l If the PC is in use and not compliant with IEC 60950 or IEC 60601-1 3rd, use optical USB
connection Type OPTICIS M2-100-03 with power supply type Friwo FW7662M/05 or type
Friwo FW8002M/05.

l Use only with the power supply that is supplied with the system - type Friwo
FW7362M/15 or type Friwo FW8030M/15.

l Any serious incident that has occurred in relation to the device should be reported to the
manufacturer and the competent authority of the Member State in which the user and/or
patient is established.

6.4 HIT Unit
l The Hearing Instrument Test Unit is a laboratory equipment and must not come into

contact with the patient. The hearing instrument used in the HIT Unit must NOT be
connected to HIT Unit and the patient at the same time.

6.5 Contraindications
l Patients unable to cooperate because of young age or other conditions cannot undergo

pure tone or speech audiometry. They may need to have the auditory system tested by
other methods.

l The patient shall be asked about any exposure to loud noise during the previous 24
hours, as this can cause a temporary hearing loss. If the answer is yes then it may be
necessary to re-test the subject at a time when they have had no recent exposure to
noise.

l Audiometry shall be preceded by otoscopic examination. Occluding wax may be removed
prior to audiometry but if wax is removed the procedure shall only be undertaken by
someone who is qualified and competent to do so.
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7 Precautions
7.1 Principles of Operation
7.1.1 Audiometry

l Presentation of pure tone sine wave and speech stimuli for threshold determination and
supra-threshold testing within the range of 125 Hz to 16 kHz and varying intensity levels
to assess client hearing levels.

7.1.2 Real Ear Measurement

l Please also note the REM standard IEC 61669 mentioned in Chapter 4. Besides technical
specifications, terms and definitions, it contains additional helpful recommendations
regarding the test set up, such as location of subject and tester, or location of field
reference and measurement point.

Presentation of pure tone sine wave or complex stimuli within the range of 125 Hz to 16
kHz for measurement at the ear drum by means of a flexible probe tube inserted into the
ear canal. The measurement may take place with or without a hearing instrument
inserted.

7.1.3 Hearing Instrument Test System

l Presentation of pure tone sine wave or complex stimuli through a loudspeaker or teleloop
system within the range of 125 Hz to 16 kHz. Measurement and quality inspection of
hearing instruments in a dedicated hearing instrument test chamber.

7.2 Measurement Accuracy
If the accuracy of the device measurements does not seem reasonable, check the device for
proper functionality. The measurement and signal presentation data, including stability,
exactness and tolerances appear from the section Technical Specification.

Inaccurate measurements may be caused by factors such as:

l Excessive ambient noise in the test environment

l Excessive movements by client or operator

l Occlusion of the outer ear by hair or jewellery, or occlusion of the ear canal by objects or
cerumen

l Incorrect placement of headphones, probe microphone set or free-field loudspeakers
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l Incorrect headphones, loudspeakers or probe microphone set, or components such as
cables, ear cushions, etc.

l Malfunction of the headphones or the device

WARNING! Use of the device in any way other than as described in this document may
result in inaccurate results or injury.

7.3 EMC (Electromagnetic Compatibility) Precautions
The Primus system is suitable for use in all establishments other than domestic, but it can be
used in domestic establishments and those directly connected to the public low-voltage power
supply network that supplies buildings used for domestic purposes, if the following warning is
taken in account:

WARNING! This system is intended for use in professional healthcare environment only and
might interfere or be disturbed by nearby equipment, therefore, it may be necessary to take
mitigation measures, such as reorienting, relocating or shielding the location.

Install and operate the Primus System according to the EMC information, warnings and
recommendations to prevent adverse events to the patient and operator due to
electromagnetic disturbances for the expected service life time.

WARNING! Failure to comply with the precautions listed in this section may cause
presenting of unwanted hearable noise or a wrong output on patients headset and therefore
the possibility of wrong client response.

WARNING! Do not place the system on or near equipment that generates a strong magnetic
or electrical field, as this may cause improper operation and interfere with the intended use of
the device.

RECOMMENDATION: To reduce the frequency of electrical shocks through ESD, the floors
should be wood, concrete or ceramic tile. If floors are covered with synthetic material, the
relative humidity should be at least 30%.

RECOMMENDATION: The quality of the mains power should be that of a typical commercial or
hospital environment.

WARNING! Use of this equipment adjacent to or stacked with other equipment should be
avoided because it could result in improper operation. If such use is necessary, this equipment
and the other equipment should be observed to verify that they are operating normally.

WARNING! Use of accessories, transducers and cables other than those specified or
provided by the manufacturer of this equipment could result in increased electromagnetic
emissions or decreased electromagnetic immunity of this equipment and result in improper
operation.
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WARNING!: Portable RF communications equipment (including peripherals such as antenna
cables and external antennas) should be used no closer than 30 cm (12 inches) to any part of
the Primus System including cables specified by the manufacturer. Otherwise, degradation of
the performance of this equipment could result.

For more information on the conformance of the system with the EMC standard EN 60601-1-2,
refer to Appendix B.

8 Installation and Set-Up
This installation procedure assumes that you will make a full installation. Skip irrelevant parts,
if you are not going to install all the modules.

Be sure to observe the safety requirements stated in this document, both during installation
and whilst using the Fitting system’s instrumentation and transducers. Do not connect external
devices unless they are suitable for connection to the Fitting System.

8.1 Hardware Setup
Note: No user-serviceable parts are found inside the Fitting Unit. Do not disassemble or modify
the unit!
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8.1.1 Fitting Unit setup procedure

1. Unpack the Fitting System and cross-check that all ordered parts (as indicated on the
delivery note) are included. If any parts are missing, please contact your manufacturer for
support immediately.

2. Slot the appropriate connector to your power supply.

3. Fasten the Fitting Unit on a wall, under a table or place it on a stable surface. (If
considered more practical, the Fitting System can also be placed inside the audiometric
booth) or piggyback to the HIT unit.

4. Connect the USB cable to the inlet marked USB on the Fitting Unit.
5. Connect the other end of the USB plug into an empty slot on the operator PC.
6. Connect the power adapter to the DC inlet.
7. At the other end, connect the power plug to a power socket.

8. The plugs on the individual transducers come in specific colours, and should be plugged
into the connector marked with the same colour on the Fitting Unit. The name of the
connector is indicated next to the colour-marking on the Fitting Unit (see the table under
the picture).
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No Table: Connectors for use in the Fitting
Unit (plug/type in parenthesis)

Name on the Fitting Unit (and
colour of transducer connectors if
highlighted)

1 DC power adapter (pin/hole) DC power

2 USB cable (USB type B, 2.0) USB

21 Sony/Philips Digital Interconnect
Format S/PDIF*3

3 Free Field Speaker, left (passive type)
(Anitek, H5-02-1-0-5-0) Left

4
Free Field Speaker, middle (passive
type)
(Anitek, H5-02-1-0-5-0)

Mid

5 Free Field Speaker, right (passive type)
(Anitek, H5-02-1-0-5-0) Right
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No Table: Connectors for use in the Fitting
Unit (plug/type in parenthesis)

Name on the Fitting Unit (and
colour of transducer connectors if
highlighted)

6-8
Free Field Line Out (3.5 mm Stereo Mini
Jack for connecting active speakers or
amplifiers)

Left/Right - Rear - Sub/Mid*1*2

Line Out 1 - Line Out 2 - Line Out
3*3

9 Client/Demo Headset (3.5 mm Stereo
Mini Jack)

Client Headset*1*2

Demo Headset*3

10 Option (DIN 8 pin) Option *2*3

11 Operator microphone, left (3.5 mm
Stereo Mini Jack) Left Operator Microphone

12 Operator microphone, right (3.5 mm
Stereo Mini Jack) Connector not used

13 Talk-back microphone (3.5 mm Stereo
Mini Jack) Talk Back Microphone

14 Operator headset for monitoring (3.5
mm Stereo Mini Jack) Monitor Headset

15 Air conductor (DIN 8 pin)

Air Conductor 1*4

Air Conductor 2*4

Air Conductor 3*4

16 Alternative air conductor (DIN 8 pin)

Air Conductor 1*4

Air Conductor 2*4

Air Conductor 3*4

17 High-frequency air conductor (DIN 8
pin)

Air Conductor 1*4

Air Conductor 2*4

Air Conductor 3

18 Bone conductor (DIN 8 pin) Bone Conductor

19
Client Response push button (DIN 8
pin)/Free field calibration tool (DIN
8pin)

Client Response

20 Probe microphone set (DIN 8 pin)
Primus Probe *2

Real Ear Probe*3*4

*1 This plug is only available in the PFU.
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*2 This plug is only available in the PFU+.

*3 This plug is only available in the Primus Pro.

*4 Frequency above 8 kHz will be unavailable.

No Table: Connectors for use in the Fitting
Unit (plug/type in parenthesis)

Name on the Fitting Unit (and
colour of transducer connectors if
highlighted)

1 DC power adapter (pin/hole) DC power

2 USB cable (USB type B, 2.0) USB

3 Free Field Speaker, left (passive type)
(Anitek, H5-02-1-0-5-0) Left

4 Free Field Speaker, right (passive type)
(Anitek, H5-02-1-0-5-0) Right

5 Operator microphone (3.5 mm Stereo
Mini Jack) Operator Microphone

6
Free Field Line Out (3.5 mm Stereo
Mini Jack for connecting active speak-
ers or amplifiers)

Line Out/Demo

7 Talk-back microphone (3.5 mm Stereo
Mini Jack) Talk Back Microphone

8 Operator headset for monitoring (3.5 Monitor Headset
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No Table: Connectors for use in the Fitting
Unit (plug/type in parenthesis)

Name on the Fitting Unit (and
colour of transducer connectors if
highlighted)

mm Stereo Mini Jack)

9 Air conductor (DIN 8 pin) Air Conductor

9 High-frequency air conductor (DIN 8
pin) Air Conductor*1

10 Bone conductor (DIN 8 pin) Bone Conductor

11
Client Response push button (DIN 8
pin)/Free field calibration tool (DIN
8pin)

Client Response

*1 Frequency above 8 kHz will be unavailable.

9. Connect the speakers into the speaker inlets.

10. Optional: Connect the operator microphones, headset and additional freefield speakers
to the appropriate sockets (see the above lists).

11. Make sure that all cables are routed and fastened to prevent  a hazard (such as
entanglement) to personnel or clients.

12. Close the Fitting Unit using the lid.

Note: The unit has no physical user interface (apart from the on/off lamp, which is visible
through the lid itself). Hereby, in order to protect it from dust and unintended disassembly, it is
recommended to keep the lid on during use. 

8.1.2 HIT Unit setup procedure

1. Place the HIT Unit on a stable surface.
2. Connect the USB cable to the inlet marked USB on the HIT Unit. Connect the other end

of the USB plug into an empty slot on the operator PC. Connect the power adapter to the
DC inlet, if performing tests are up to 16kHz.

3. To adjust hearing aid settings with HI-PRO or NOAHlink™, connect the HI-PRO box or
NOAHlink™ to the appropriate INTERNAL HI CONNECTOR outlet using the extension
cables provided (as shown in the picture below).
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HIT Box HIT Pro

4. Plug in the hearing aid programming lead to start programming with a HI-PRO or
NOAHlink™.

Note: You can also connect the HI-PRO box or NOAHlink™ directly to the operator PC.
The plug in the hearing aid programming leads directly to the HI-PRO box.

HIT Box HIT Pro
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5. Optional: Connect a monitor headset to the MONITOR socket.

HIT Box HIT Pro

6. Plug the reference microphone, coupler and battery pill in the inlets as shown below.
You can also place the necessary sponge provided to support the hearing aid. Please
refer to Section 9.2, Set up and editing for hearing instruments in the User Manual for
more information.

HIT Box HIT Pro

No Name
1 Coupler microphone

2 Battery pill

3 Hearing aid programming lead (HI-Pro cable)

4 Reference microphone

5 Hearing aid holder

6 Coupler microphone holder

8.2 Software Installation
8.2.1 Prerequisites

At least version 4.7 (or higher) should be installed if you are using NOAH.
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8.2.2 Installation Procedure

You will receive the Fitting System software on a USB memory stick. Insert the USB stick into a
USB slot.

The installation should now start automatically. Follow the instructions on the screen.

If the installation does not start automatically, do as follows:

1. Open Windows Explorer and locate the USB stick.
2. Locate the setup_x.x.x.x.exe file and double-click it.
3. The installation program will now guide you through the installation procedure.
4. Follow the instructions on the screen.

Note: Starting from version 2.1.0.0, you will need to install an additional driver for the Primus
Video Otoscopy module. During the installation of the Primus software, you will be asked to
allow the installation of these drivers:

You must click Install or the installation will be cancelled.

8.2.3 Updates

When a new software version is available, you can download it from the Internet. Open
Auditdata A/S' homepage, www.auditdata.com from the Support section.
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8.3 Installing Your License
The first time you start the application you will see a notification concerning using an
unlicensed copy of the program. If you have already obtained your license from the
manufacturer, proceed with the following steps to activate your license:

1. In the License Notification dialog box, click Show License Info.

2. In the License Information dialog box > Licenses tab, you have two options: Import and
Enter Code.

3. Click Import to navigate to the location of the license file and then click Open.

4. If you have the license key printed, click Enter Code and enter your unique key. Then
click Ok.

5. After re-starting the application, installation of the license is complete.

8.3.1 Calibration and Adjustments

When you have finished the software installation and hardware setup, proceed to calibrate the
free field loudspeakers (if any) and to make an initial adjustment of the attached microphones
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and headsets. After calibration and adjustment, the system is ready for use.

Information on Connected Devices and Calibrations will be shown on the corresponding tab of
the License Information dialog box.

8.4 Test Definitions Set-Up
Test definitions are pre-configured measurements based on the test types available within the
system. You can locate them by opening Tools and then clicking Test Definitions.

Use the Add, Edit and Remove buttons to set up test definitions for the main modules, namely:
Audiometry, Real Ear Measurement, Speech Mapping and HIT.
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You can create and name new custom test definitions for each measurement by configuring the
signal type, level, transducer, masking stimulus for each test.
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It is also possible to specify the completeness criteria by checking that the selected frequencies
are measured during the test.

Enable consistency criteria to check whether AC and BC thresholds need to be masked. Also,
check that the threshold levels are according to the following rule: UCL > MCL > AC >= BC.

More details about setting up various Primus modules can be found in the System’s Help.

8.5 Configuring Types of Visits
Please familiarize yourself with the Types of Visits lists. The Types of visits list itself is available
right below the Сlient tab.
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The application is shipped with a set of predefined visits. You can add, delete or edit them. To
do this, open the Tools menu, click Settings, then Workflow in the General section, and use
Add/Delete/Edit buttons as needed.

If you do not wish to use some of the modules, you may disable it by deselecting the check box
under the Enable modules heading. Those modules will now not be shown in the workflow list
on the main screen.
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Each task group consists of relevant tasks which you can select using the arrow buttons to
move to the selected tasks box to add to your workflow. Once you have selected all your tasks
required, use the Up and Down button to change the order of your selected tasks.

In the main window of the application, the task groups are represented by the tabs located right
below the task list.

8.6 Activating Workflow Support
The system includes a workflow support utility which guides you through the necessary
measurements step by step. The purpose is to provide the ability to follow company defined
test protocols and open the particular test steps in their predefined configuration. For each
workflow step you can define type of measurement, stimulus, level, frequencies, etc. It is
possible to set each workflow step as an optional or mandatory step.

You can define as many workflows as you want depending on your needs. However, only one
workflow can be activated at a time.

To enable workflow support, go to Tools and select Settings where you click the Workflow tab.
Select the corresponding check box to activate workflow support.
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Note: Activating workflow support disables the types of visits functionality in the user interface.

To configure workflows, go to Tools -> Test Definition. Select a workflow entry from the list and
click Edit to open it. Use the buttons in the right panel to add new workflows, edit existing ones
or delete any workflow from the list.
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To define the setps within the workflow, click the Edit button to open the configuration window.
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As you add the steps, you need to specify the test type, set its prospected duration and set test
step as mandatory or optional.

Note: There are three specific step types that display a message to the audiologist, prompt
them to enter a note, open an external file (website or presentation), called Display a message,
Prompt a user to add a note, and Open External Link correspondingly.

After restarting Primus, you can find the workflow on the top panel of the application.

After the workflow support has been activated, click the Start button to begin. The first workflow
step will be highlighted and after clicking on it you will be directed to the corresponding module
and the preconfigured test will open up. Each step is coloured according to its state:

l Yellow - Incomplete
l Green - Done
l Red - Skipped
l Dark Grey - Active Step
l Blue - Not Done
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If the criteria for the test type are not fulfilled, the application will notify you when you attempt
to move to the next step. You can see what criteria was not met and make required changes to
the measurement.

You must enter a reason why the criteria cannot be fulfilled or change the test to meet the
criteria requirements.

8.7 Calibration of Free-Field Loudspeakers - Sound Field Cal-
ibration
Free-field loudspeakers must be calibrated before performing any audiometric testing.

The calibration of the free-field loudspeakers is only valid for the exact distance from the
client's ear for which they are calibrated at.

Therefore, free-field loudspeakers should be re-calibrated if they are moved from the exact
location at which they were calibrated.

For the following procedure it is assumed that the connected loudspeakers are of a high quality,
particularly with respect to linearity and maximum sound pressure.

Procedure

1. Place the free-field loudspeakers at a distance no further than 1 m and angle the
speakers, for example at 45° or 0° azimuth from where the client's ear will be during
tests. The center of the loudspeaker should be at the same height as the ear canal.

Note: The calibration must be repeated if the client has moved from the original calibration
distance.

2. In the case of active loudspeakers, make sure that the volume is set to maximum.
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Note: Some active loudspeakers may be too sensitive and will produce distortion noise,
when set at maximum volume. In that case, try to reduce the volume (if max. output can be
reached) until you find a level where max. output level can still be reached and noise from
the loudspeaker system is acceptable.

3. Open the Fitting System program, go to Tools > Settings > General > Loudspeaker
selection and select the correct speaker for pure tone, speech, REM, and SM according to
your setup.

Note: A password is required to access this function.

4. Click Save to confirm the specified settings.

5. Select Sound Field Calibration from the Tools menu.

6. The window contains the history of performed calibrations. Click Do Calibration to start a
new calibration.
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7. In the Calibration of Free Field Loudspeakers dialogue box, enter the name of the
technician who performs the calibration, select the module you want to calibrate and a
calibration method:

8. If you have selected external SPL meter, in the next Setup window, select the speakers you
wish to calibrate.

Also check-mark the box at the bottom if the calibration should include the high-frequency
area.

Note: High frequency calibration option is only available when the pure tone audiometry
module is selected.
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If you are using the built-in microphone, select Left or Right Probe-mic to measure the
levels with.

Note: The REM probe microphones must be calibrated before being used to calibrate the
loudspeakers.

If you are using the free field calibration tool, levels will be measured with the free field
calibration microphone.

Note: When using the Primus Ice, you should calibrate by selecting the external SPL meter
or the free field calibration tool.

9. Set the level you wish to calibrate at.
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10. Select Speech Noise- ILTASS for signal for sound card calibration.

11. Place the SPL meter, free field calibration microphone, or Real Ear Probe at the exact
location where the client's ear will be tested.

12. Observe the instructions at the top of the Setup window, and click the Start button. (You
will get a warning, if any selected instruments are not connected and turned on).

If you use the SPL meter, you will need to set the level manually, using the correction
values shown in the image below. If you want to add 2 dB to the level, for example, just
press +1 twice. Once you are fine with the level, click the Next button.

13. When using "Built-in Microphone" or free field calibration tool, and more than one speaker
were selected, the procedure will continue automatically for other loudspeakers. If one or
more frequencies cannot be calibrated, a warning will appear. At the end of the calibration
a report will be displayed, showing any uncalibrated frequencies or levels.

14. Click OK to save the calibration and exit the Loudspeaker Calibration dialogue box.

15. By means of markings or fastening, make sure that the loudspeakers will be placed in this
exact position compared to the client's location during testing.

You can import and export calibration data in the XML format using the Import and Export
buttons correspondingly. After you click Import, locate the saved calibration XML file on your PC
and click Open. Proceed to calibration afterwards. To export your calibration data, click the
Export button and save the XML file to your local computer.

Use the Print Report button to print the calibration report.
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8.8 Addition of External Sound Files for Speech Audiometry and
Speech Mapping
To add a new media files folder:

1. On the CD and Media Files Folders, click Add button to add a new folder with your own
sound files (wav, ogg, wma) or get the files from the Cloud. The Custom Media files
Folder window opens.

2. Specify the Name of the external folder.

l If you are planning on using the speech materials from the Primus Cloud, activate
the corresponding option.

3. Select the Folder Path where the external folder is located.

4. Select the CD Scheme that corresponds to your sound files and click the Calibrate
button.

5. Select the track or special sound which will calibrate your sound files.

6. Calibrate the selected files and click Save button and then OK to save again.

The calibration of recently calibrated file will be used for all external sound files in Speech
Mapping and Speech Audiometry modules.

Note: Only one calibration value is available and used for all external sound files and will be
applied to all transducers.
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8.9 Calibrating Speech CD Material
To adjust the output level for speech material:

1. Select Settings from the Tools menu.

2. In the Settings dialogue box, select CD and Media Files Folders from the General folder.

3. In CD and Media Files Folders Settings, click the button Calibrate CD... to open the CD
Calibration window.

4. Adjust the CD Offset to the correct value in dB if the CD contains an offset value.

The value in the field “CD Offset” has only effect on the free field speakers, but not on the
transducers. It will increase or decrease the common reference output level for the sound
field speakers according to the value entered. A change of the offset value does not
influence the VU meter level displayed.

Important Note: The required CD offset value should only be obtained in conjunction with
a proper calibration equipment (sound level meter) to measure the output level of the
sound field speaker.

Warning: Only recorded speech material with a stated relationship with the calibration
signal should be used.

5. Select the calibration track on the CD and click Start Calibration.
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6. During the calibration adjust the level so the VU meter is around 0 using the ‘+’ and ‘-’
buttons.

7. Click Save to save the setting and exit the dialogue box.

8.10 Selecting Client and Entering Client Data
If client data has been saved in the Noah database, the client's name will appear in Noah’s
Patient Browser.

To start the program as a Noah module, you have to select the client in the Patient Browser and
then click Primus in the module list.

The application opens with the client's data displayed in the dashboard of the application.

If you need to create a client in Noah, open the Noah File menu, click Add New Patient, and
then fill in the client data. Please note that fields marked in orange are mandatory.

If the application has been started outside the Noah system, you have to enter the client’s data
first. Open the Tools menu, click Client Information, and then fill in the client data.
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Once you click OK, the client’s name, date of birth and some other data will appear in the top
title bar. To choose which information to display in the title bar, go to Settings > General >
Client Information and select the appropriate checkboxes.
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Alternatively, you can import client data that were previously exported from the application:
open the File menu, click Import Sessions and then specify the location of the XML file with the
client data.

8.11 Obtaining Hearing Threshold Levels
Prior to performing audiometric measurements with your client, please ensure the following:

For the client:

1. The client has a comfortable seating in the sound-attenuating booth.
2. The appropriate testing headsets are plugged into the appropriate sockets.
3. A client response switch is connected to the CLIENT RESPONSE socket of the

Fitting Unit.
4. Optionally, a microphone for the client talk-back is connected to the TALK BACK

MICROPHONE socket on the Fitting Unit.

For the operator:

1. Optionally, a monitor headset with boom microphone can be connected to the
MONITOR HEADSET socket of the Fitting Unit for talk-back monitoring.

2. Optionally, a separate microphone is connected to the LEFT/RIGHT OPERATOR
MICROPHONE socket for talk-over monitoring.

Click on the icon on the Audiometry tasks tab in the application to open the Audiometry front
page in the dashboard.

Click the Pure Tone Measurement button ( ) in the Audiometry pane of the
dashboard to open the Pure Tone Measurement window.
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Make sure that HTL is selected in the Test Types panel in the top left corner of the window.

To select the HTL test type, simply click it. Alternatively, you can press the T button on the
keyboard.

Check the settings on the Measurement Controls panel below the audiograms:

1. Select ear by means of the blue ( ) or red ear button ( ). Alternatively, use the L
button on the keyboard for the left ear and the R button for the right ear.

2. Set frequency and amplitude by means of the "+" and "-" buttons. Alternatively, use the
arrow left/right and up/down buttons of the keyboard.

3. Configure the necessary masking settings.
4. Click the Talk Over ( ) and Talk Back ( ) buttons below the ear icons—F2 and F3

keys on the keyboard—to activate the Talk-Over and Talk-Back functions. If you need to
adjust the talk-over/back levels, click the Settings button ( ) to open this setting menu.

For a complete list of keyboard shortcuts, please refer to the Help file. To open it, go to the Help
menu of the application and click Get Help; alternatively, press F1 on the keyboard.

Click the button, or press the spacebar on the keyboard, to present a signal to the
client. When the client is capable of catching the signal of a certain frequency and level, he or
she responds by using the response switch. When this happens, the colour of the Frequency
Levels pane changes.
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Click the button, or the S button on the keyboard, to mark the point in the
audiogram.

Refer to the Help file for a detailed description of the procedure.

When you have obtained all required data for both ears, click Save—the button is active if
Primus is opened as a Noah module—and then Close, in order to save your measurement data.

After that, a corresponding item appears in the Measurement History pane of the dashboard. If
you place the mouse pointer over the history item, the corresponding audiogram will be shown
in a large format.
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8.12 Displaying Counselling Material to Client
Before the client’s first visit it is recommended that you spend some time on getting acquainted
with the System’s presentation material. The material is available on the Opening Counselling
tab of the application.

For your client’s convenience you may attach an extra monitor to your PC in order to display the
presentation to him or her - the video card in your PC must have an extra video port for this to
work.

To open/close this mirror image of the Primus window to the client, use the Show/Hide Client
View button in the lower right-hand corner of the main Primus window. 

If you do not wish to use the counselling module, you may disable it by unchecking the box
Counselling from the Settings dialog box. The counselling module will not be shown in the
workflow list on the main screen.
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8.13 Shutdown Procedure
Closing Application

To safely close the application:

1. Select File > Exit or use Alt+F4. If you made any measurements, the system will show
the warning: 

2. Click Yes to save the session data and close the application. Click No if you want to close
the application without saving of data.

Disconnecting Fitting and HIT Units

For the Unit that uses the Opto-USB cable without power DC adapter: disconnect the USB cable
from the instrument and the USB power supply from the mains power outlet.

For the Unit that uses DC adapter and non-optical USB: disconnect the USB cable from the
instrument and then disconnect the DC adapter both from the instrument and the mains power
outlet.

For the Unit that uses non-optical USB without power DC adapter: disconnect the USB cable
from the instrument.

For the Unit that uses the Opto-USB cable and power DC adapter: disconnect the USB cable and
the USB power supply from the mains outlet and then the power DC adapter from the
instrument and the mains power outlet.

8.14 Regular System Checks
8.14.1 Adjusting Speech Audiometer input level

Prior to speech testing, it is recommended to check the VU-meter for proper sensitivity level. For
this, you should play a CD calibration signal and adjust the input sensitivity to 0 dBVU.

8.14.2 Calibration of probe tube and reference microphone (in REM and SM)

Prior to real ear measurement session or when replacing the probe tube with a new one, ensure
the correct probe tube calibration. If it is calibrated properly, you should see a flat curve once
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measuring a REUG with the probe tube still kept in the calibration position.

8.14.3 HIT box calibration

On a regular basis (e.g. once per day), check the proper coupler microphone sensitivity and
calibration. The procedure is as follows:

1. Unscrew the coupler microphone body to expose the coupler microphone diaphragm.

2. Place it close against reference microphone without it touching.

3. Conduct an OSPL90 measurement, you should see a flat line at 90 dB.

9 Maintenance
9.1 Annual Calibration of Headset and Transducers
The headset and transducers delivered with the Fitting System and reference and coupler
microphones delivered with the HIT Unit are NOT intended for calibration by users. Contact your
local distributor for your annual service and calibration.

9.2 Adjustment of Common Headsets and Microphones
All calibration of the Primus Fitting System and transducers delivered with the system has been
made by the manufacturer before shipment. The system’s accessories should be re-calibrated
annually by the supplier or their appointed representatives to ensure system integrity.

Depending on your license agreement, however, you may have access to perform calibrations
locally. In this case some extra options, like Headphones Calibration, REM Calibration, and HIT
Microphone Calibration, can be done with a separate calibration tool.

9.3 Inspection
On a regular basis, that is, at least once a week, perform a visual inspection of the Fitting and
HIT Units and their accessories for visible damages. During use, evaluate the test results and
perform a system inspection if the results appear unreliable.

9.4 Cleaning
9.4.1 Disposable parts

Parts such as foam tips on insert earphones or probe tubes for real-ear measurement are
not intended for reuse. Dispose of such items in a hygienic manner after each client session.

9.4.2 Reusable parts

Maintain a high level of hygiene and clean reusable devices which come into contact with
clients between each use. See the cleaning instructions below.
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9.4.3 Cleaning instructions

l For cleaning use only a soft dry cloth dampened very sparingly with a low level
disinfectant solution such as isopropyl alcohol to wipe the device. Do not allow excess
solution to enter the device as this may damage internal components.

l Do not autoclave, pressure sterilise, or gas sterilise the device or any of its electrical
accessories.

l Do not soak or immerse the device in any liquid.
l Do not use acetone or paraffin/kerosene-based solutions, or any other harsh solvent to

clean the device or its accessories. Use of such substances may be harmful to the
equipment and may result in faulty operation.
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10 Troubleshooting Guide
If you have any problems with installing or running the software, please go through this guide
first before contacting a Support/HOT-line.

Please verify that the following installation prerequisites are satisfied:

l The Fitting System software supports Windows 8.1 (does not support Windows RT
version), Windows 10, Windows 10 Anniversary Update and Windows 11 operating
systems.

l Local administrator rights are required in Windows to install the Fitting System software.
l The Fitting System software supports NOAH 4 or higher.

Before starting the troubleshooting – please ensure that you do the following steps:

l Unplug the USB cables and power supply (if available) from the unit.
l Re-start the computer.
l Connect the unit to the computer using the USB cable.
l Connect the power supply to the unit, if available.
l Check that all available headsets, speaker and other accessories are connected to the

unit.
l Run the Fitting System software.
l Check that the unit is connected properly:

l In the Fitting software status bar the device is shown as Connected:

l Power light on the unit is permanently on.

If any of the above steps failed, please refer to the below table for the solution of your problem.

Problem Action
Software installation problems

l Setup can’t be completed
successfully (when running
the setup_x.x.x.x.exe).

l Use only the supported Windows operating
systems.

l Use the latest Windows service packs.
l Use the latest Fitting System software setup.exe

from Internet
(www.auditdata.com/support/primus-
support/download).

Software set-up problems
l The stimulus button in the

Audiogram is greyed out.
l At start-up of the Fitting

System the “License
notification” message is
shown.

l The License code is not activated. Please activate
the license from the help menu and follow the
description for the activation of the license code.
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Problem Action
Hardware connection problems

l In the Fitting Software
System’s status bar under
“AUD HW/ HIT HW” it says:
“Not connected”.

l Reconnect a USB cable and power supply, if
available. Check that the units are connected. (See
the status bar in the software).

l Try another USB port on the computer.
l Try another USB cable.
l If connection is done via hub/switch, connect

directly to computer.

l No sound in headset or
speakers, etc.

l Ensure that the unit is connected to the computer
using the USB cable.

l Power light is steady on.
l Plug and unplug all headsets.
l Reconnect USB cable and power supply, if

available. Check that the units are connected. (See
the status bar in the software).

l No output from the speaker
in REM.

Ensure that you have selected the correct speaker in the
Tools > Settings > General > Loudspeaker selection >
REM. Then calibrate your REM probe tube.

l Power light is not steady at
start-up of the Fitting
Software System.

l Re-start the Fitting Software System.
l Reconnect USB cable and power supply, if

available. Check that the unit is connected. (See
the status bar in the software).

l Check that the unit is displayed in Windows device
manager under sound devices. If not, please
contact support.
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Appendix A
A.1 Declarations of Conformity
A.1.1 Primus Fitting Unit+ (PFU+)
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A.1.2 2000 Primus HIT Pro
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A.1.3 2000 Primus Fitting Unit Pro
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A.1.4 2000 Primus Audiometer Unit Ice
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A.2 Manufacturer

The Fitting System is manufactured and sold in the EU by:

Auditdata A/S

Wildersgade 10B
1408, Copenhagen
Denmark
Phone: +45 70203124

www.auditdata.com

0123

PRIMUS FITTING UNIT+ (PFU+)

2000 PRIMUS HIT PRO

2000 PRIMUS FITTING UNIT PRO

2000 PRIMUS AUDIOMETER UNIT ICE
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Appendix B
B.1 Technical Specification
B.1.1 Primus Fitting Unit

Item Description Value
Mechanical Data:

Primus Fitting Unit, without
cover

Primus Pro, without cover

Primus Ice, without cover

External measures L x W x H
Weight

External measures L x W x H
Weight

External measures L x W x H
Weight

345 x 110 x 35 mm
475 g

345 x 112 x 35 mm
500 g

167 x 110 x 32 mm
375 g

Primus Fitting Unit, with
cover

Primus Pro, with cover

Primus Ice, with cover

External measures L x W x H
Weight

External measures L x W x H
Weight

External measures L x W x H
Weight

350 x 120 x 130 mm
800 g

360 x 120 x 96 mm
900 g

181 x 115 x 94 mm
550 g

Electrical Data:

Power supply, low

power output

5 volts USB power max 500 mA

Provided power
supplies for USB power in
conjunction with OPTO USB
cable (Type OPTICIS M2-
100-03)

type Friwo FW7662M/05 Input voltage 100-240 V,
50/60 Hz, 150 mA; output
voltage 5 Vdc, 1.1 A

type Friwo FW8002M/05
Input rated 100-240 V
±10%, 50/60 Hz, 160 mA.
Output rated 5 Vdc, 1.4 A

Provided power
supplies for high power
output functionality

Direct plug-in power supply, type
Friwo FW7362M/15

Input voltage 100-240 V AC,
50/60 Hz, 700 mA; output
voltage 15 Vdc, 2.0 A

Direct plug-in power supply, type
Friwo FW8030M/15

Input rated 100-240 V
±10%, 50/60 Hz, 300 mA.
Output rated 15 Vdc, 2.0 A

Free-field output w/overload protection 3 channels, each up to 20
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Item Description Value
watts in 4 ohms.

Left/Right, Sub/Mid, Rear
Free Field Line Out*1*2

Line Out 1/Line Out 2/Line
Out 3 - Free Field Line
Out*3

500 mV RMS max load 16 ohms

Client*1*2/Demo*3 and
Monitor Headset output 500 mV RMS max load 16 ohms

Operator Electret microphone powered
inputs

-40 dB+/-5 dB
(0 dB = 1 V/pa, 1000 Hz)

Talk back mic Electret microphone powered
inputs

-55 dB+/-4 dB
(0 dB = 1 V/pa, 1000 Hz)

REM Probe input Electret microphone powered
inputs

Refer to sec. B.2.2

Air and Bone Conductor
Outputs

For Tone and Speech:
3 Vrms (w. external power
supply)
1 Vrms (USB only)
125 Hz – 16 kHz Frequency
Range For Bone Conductor:
250 Hz - 8kHz Frequency Range

Max load 4 ohm

Calibration Refer to a separate manual for
calibration instructions.
Tone and Speech signals are cal-
ibrated for Max Hearing Level
Tolerance: +/- 3 dB (up to 8 kHz)
+/-5 dB (8 kHz and higher)
Masking signals are calibrated
for Max Sound Pressure Level

Client response button Normally open contact and I2C
data wire with 3.3 volts
protected power supply

Fuses Autofuses

Environmental Data:

Warm-up time (if stored at room temperature) 1 minute

Primus Measure Solutions
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Item Description Value
Operating temperature 5°C – 40°C

Storage temperature -30°C - 70°C

Humidity 5% - 90%

Air pressure (altitude) 70 kPa (3000 meter) to
106 kPa (-400 meter)

Connectors:

DC power Pin 2.5 mm/Hole 7.0 mm

Pin: positive supply (+)
Ring: negative supply (-)

USB 2.0 and USB 3.0 Complies with 60601-1 3rd or
IEC 60950-1

S/PDIF*3 Optical Audio TOSLINK connector

Left speaker/Middle
speaker/Right speaker

Anitek, H5-02-1-0-5-0 3 pcs.

Line Out 1/Line Out 2/Line
Out 3 - Free Field Line
Out*3

Left/Right, Sub/Mid, Rear
Free Field Line Out*1*2

Stereo mini jack 3.5 mm

Operator and talk back mic
input

Stereo mini jack 3.5 mm

Client*1*2/Demo*3 and
Monitor Headset output

Stereo mini jack 3.5 mm

Air conductor 1 DIN 8 pin

Air conductor 2 DIN 8 pin

Air conductor 3 (high
frequency)

DIN 8 pin

Bone Conductor DIN 8 pin

Client response DIN 8 pin

Option*2*3 DIN 8 pin

Primus Probe*1/Real Ear
Probe*2*3 input

DIN 8 pin

Parts and Accessories*: Description

Primus AUD (in Fitting Unit) Clinical audiometer

Primus REM (in Fitting Unit) Real ear measurement unit

Primus Measure Solutions
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Item Description Value
Primus Speech Mapping Speech Mapping with Live voice

and Percentile Analysis

AUD/REM DC adaptor 15 volts/2A

Optical USB connection Type OPTICIS M2-100-03

Headset with microphone Monitor headset w/boom
microphone for operator
monitoring and talk over

Headset without
microphone

Monitor headset

Microphone Table microphone for talk over
or talk back

Extension cord f/sound
attenuating booth

Loudspeaker incl. cable Free-field loudspeaker for real
ear measurement and
audiometry

Insert Earphones Audiometric insert earphones

Ear tips (small) Insert ear tips for Primus Insert –
small (children)

Ear tips (medium) Insert ear tips for Primus Insert –
medium

Ear tips (large) Insert ear tips for Primus Insert –
large

Insert tube with nipples For the Insert earphones only.
Length 200 mm

Probe tube guide Probe tube stabilizer

*1 This plug is only available in the PFU.

*2 This plug is only available in the PFU+.

*3 This plug is only available in the Primus Pro.

Applied Parts Type B

Note: These parts must only be replaced by identical parts delivered by the manufacturer.

Item Description
Insert Phone/Insert Earphone Real Ear audiometric insert earphones

Primus Measure Solutions
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Item Description
Flex

ER-3A Insert Headset EarTone audiometric insert earphones (Model: EarTone
3A)

ER-3C Insert Headset Etymotic audiometric insert earphones (Model: Etymotic
Research type 3C)

TDH-39 Headset Supraaural audiometric headphone

HDA-200 Headset Sennheiser circumaural audiometric high frequency
headphone

HDA-280 Headset Sennheiser standard audiometric headphone

HDA-300 Headset Sennheiser circumaural audiometric high frequency
headphone

DD45 Headset Interacoustics supraaural audiometric headphone

DD450 Headset RadioEar circumaural audiometric high frequency
headphone

DD65 Headset Interacoustics circumaural audiometric headphone

DD65v2 Headset RadioEar circumaural audiometric headphone

B-71/B-81 Bone Conductor RadioEar audiometric bone conductor

Client response button Single-button response switch

Free field calibration tool Free field calibration microphone

Real Ear Probe/REM Probe Flex REM Probe, binaural real-ear measurement probe set

*) Note: The list of Parts and Accessories is subject to change without notice.
   An updated list will always be available from our homepage: www.auditdata.com

B.1.2 Primus HIT - Hearing Instrument Test Unit

Item Description Value
Indoor use

Mechanical Data:

Primus Hearing Instrument
Test Unit

External measures L x W x H 350 x 320 x 125 mm

Weight 4.5 kgs

Electrical Data:

Power supply, low power 5 volts USB power max 500 mA

Provided power supplies

for USB power in conjunction
with OPTO USB cable (Type

type Friwo FW7662M/05 Input voltage 100-240 V,
50/60 Hz, 150 mA; output
voltage 5 Vdc, 1.1 A

Primus Measure Solutions
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Item Description Value
OPTICIS M2-100-03)

type Friwo FW8002M/05
Input rated 100-240 ±10%,
50-60Hz, 160 mA. Output
rated 5Vdc, 1.4 A.

Provided power supplies
for high power output
functionality

Direct plug-in power supply,
type Friwo FW7362M/15

Input voltage 100-240 V AC,
50/60 Hz, 700 mA; output
voltage 15 Vdc, 2.0 A

Direct plug-in power supply,
type Friwo FW8030M/15

Input rated 100-240 ±10%,
50-60Hz, 300 mA. Output
rated 15Vdc, 2.0 A

MAINS supply voltage fluc-
tuations

up to ±10 % of the nominal
voltage

TRANSIENT OVERVOLTAGES up to the levels of
OVERVOLTAGE CATEGORY ll;

NOTE 1 These levels of
transient overvoltage are
typical for equipment
supplied from the building
wiring.

TEMPORARY OVERVOLTAGES
occurring on the MAINS sup-
ply

2 500 V impulse withstand
voltage

Free-field output w/overload protection up to 20 watts in 4 ohms

Fuses Autofuses

Environmental Data:

Warm-up time (if stored at room
temperature)

1 minute

Operating temperature 5°C – 40°C

Storage temperature -30°C - 70°C

Humidity 5% - 90%

Air pressure (altitude) 70 kPa (3000 meter) to
106 kPa (-400 meter)

Applicable POLLUTION
DEGREE of the intended envir-
onment

POLLUTION DEGREE 2 in
most cases

Connectors:

DC power
Pin 2.5mm/hole 7.0mm

Primus Measure Solutions
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Item Description Value
Pin: positive supply (+)

Ring: negative supply (-)

USB 2.0 and USB 3.0 Complies with 60601-1 3rd or
IEC 60950-1

Left HI-PRO or NOAHlinkTM

input
6 pin mini DIN

Right HI-PRO or NOAHlinkTM

input
6 pin mini DIN

Monitor headset Stereo mini jack 3.5mm

Parts and Accessories*: Description

Reference microphone Installed, Electret goose neck
type

Coupler microphone Installed, Electret type

Coupler 2 cc coupler with
attachments for ITE, BTE, and
Body-worn Hearing
Instruments

Battery pills, 5 sizes Type 5A, 10A, 312, 13 and
675

BTE tube PVC tube for BTE Hearing
Instruments. Length 25 mm

ITE putty Putty for fastening of ITE
Hearing Instruments to the
ITE coupler

*) Note: The list of Parts and Accessories is subject to change without notice.
An updated list will always be available from our homepage: www.auditdata.com.

B.2 Technical Data
B.2.1 Primus AUD system

No. of  channels: Full 2 channel

Tone presentation: Steady, pulsed

Signal types: Pure Tone:
IEC 60645-3:2007
125 Hz - 16 kHz*
Accuracy within 0.2%
Modulated Tone:

Primus Measure Solutions
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125 Hz – 8 kHz
Triangular linear
10.8 Hz Repetition Rate
+/-10% Frequency Deviation
(of carrier frequency)

Masking types: Narrow Band Noise:
IEC 60645-1:2001, 1/3
Octave filter with geometric
center frequency as the
audiometric TONE frequency
White Noise:
100-20000 Hz with +3
dB/octave throughout its
frequency range

Speech-weighted:
IEC 60645-2:1997,
125-1000 Hz +3 dB/octave ,
1000-6000 Hz - 9 dB/octave

Pink Noise:
100-20000 Hz, +/-1 dB
throughout its frequency
range

Hearing levels: -10 dB - 120 dB HL

Deviation, dB: 0.5 dB

Distortion: Less than 3 % for air
conduction.
Less than 6% for bone
conduction.

* Primus Ice supports 125 Hz - 8 kHz only.

B.2.2 Primus REM system

No. of  channels: 4 channel (2 probe
microphone units with each a
reference mic. and a probe
mic.)

Signal types: White noise, speech-weighted
noise, and pink noise.
For technical specifications
refer to section B.2.1.
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Further Signals: ISTS Signal according to IEC
60118-15,
Crest factor: 17
ISTS MPO signal
Level: 90dB
SPL Frequencies: 0,5, 1, 2, 3,
4 kHz
On time: 250 ms
Off time: 250 ms
Rise- and fall time: 25 ms
ICRA Signals: (Hearing Aid
Clinical
Test Environment
Standardization)
DSL Signals: Female “S” and
“SH”
(Child Amplification
Laboratory
National Centre for Audiology
Western University London,
Ontario)

Frequency range: 125 Hz – 16 kHz

Signal levels: 50 – 90 dB SPL

Accuracy: Within 4 dB

Signal Analysis: Analysis type: FFT
Analysis bandwidth:
125 Hz to 16 kHz
Resolution: 24 bands/Octave
Windowing type: Hann

Equalization type: Modified pressure method

Sensitivity, Probe Mic. Depending on selected input
range,
10 ranges available
-35 dB (0 dB = 1 V/pa, 1000
Hz)

Sensitivity, Reference Mic. Depending on selected input
range,
6 ranges available
-35 dB (0 dB = 1 V/pa, 1000
Hz)

Measurement Range 40 dB SPL to 100 dB SPL
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B.2.3 Primus HIT system

No. of  channels: 2 channel - One coupler
microphone and one
reference microphone

Signal types: Pure tone, modulated tone,
narrowband noise, white
noise, speech-weighted
noise, and pink noise.

For technical specifications
refer to section B.2.1.

Frequency range: 200 Hz – 16 kHz

Signal levels: 40 – 100 dB SPL

Tolerance, dB: +/- 1,5 dB in the frequency
range 200 - 2000 Hz and +/-
2,5 dB in the frequency range
2000 - 5000 Hz and above.

Pure tone accuracy: +/-2%

Distortion: Less than 0,5% at 70 dB.
Less than 2% at 90 dB.

B.2.4 Primus Insert Phone/Insert Earphone Flex

Insert Phone/Insert
Earphone Flex

Including Audiometric insert
earphones

Frequency range: 125 Hz to 8 kHz

Maximum output level: Up to 120 dB HL at mid
frequencies

Compliance: EN 60645 and ISO 389-2

B.2.5 Primus Real Ear Probe/REM Probe Flex

Real Ear Probe/REM Probe
Flex

Adjustable left and right-ear
hangers, each with reference
and probe tube microphone

Frequency range: 125 Hz to 16 kHz

Maximum input level for
probe tube input:

125 dB SPL with less than
3% distortion.
Up to 135 dB SPL

Primus Measure Solutions

© Auditdata – 2023, ID: 20.0109/20

Instructions for use



B-11

B.3 EMC Conformance Requirements
B.3.1 EMC Classification, Standards and Test Methods

Emissions: EN 55011/CISPR11, Group 1, Class B

Harmonic Current Emission: IEC 61000-3-2:2018, Class A

Voltage Fluctuations and Flicker: IEC 61000-3-3:2013

Immunity: Test levels for professional healthcare environment.

Enclosure Port:

Basic EMC standard Immunity test level

IEC 61000-4-2 (ESD) ± 8 kV contact, ± 2 kV, ± 4 kV, ± 8 kV, ± 15 kV air

IEC 61000-4-3 (rad. Fields) 3 V/m, 80 MHz – 2,7 GHz, 80 % AM at 1 kHz

& Test points / frequencies according to table 9 of
IEC/EN 60601-1-2 (RF wireless communications
equipment):

385 MHz; Pulse Modulation: 18 Hz; 27 V/m

450 MHz, FM + 5Hz deviation: 1 kHz sine; 28 V/m

710, 745, 780 MHz; Pulse Modulation: 217 Hz; 9
V/m

810, 870, 930 MHz; Pulse Modulation: 18 Hz; 28
V/m

1720, 1845, 1970 MHz; Pulse Mod.: 217 Hz; 28 V/m

2450 MHz; Pulse Modulation: 217 Hz; 28 V/m;

5240, 5500, 5785 MHz; Pulse Mod.: 217 Hz; 9 V/m

IEC 61000-4-8 (magn. Fields) 30 A/m, 50 Hz & 60 Hz

Input a.c. Power Port:

Basic EMC standard Immunity test level

IEC 61000-4-4 (bursts) ± 2 kV, 100 kHz repetition frequency

IEC 61000-4-5 (surges) ± 0,5 kV, ± 1 kV, line to line

IEC 61000-4-6 (cond. RF) 3 V/m, 0,15 MHz – 80 MHz, 80 % AM at 1 kHz

6 V/m in ISM bands between 0,15 MHz and 80 MHz

IEC 61000-4-11 (volt. dips) 0 % UT; 0,5 cycle at 0°, 45°, 90°, 135°, 180°,
225°, 270°
and 315°. 0 % UT; 1 cycle and 70 % UT; 25/30 cycles
at 0°
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IEC 61000-4-11 (volt. inter.) 0 % UT; 250/300 cycle

Patient Coupling Port: Device has no patient coupling port

Signal Input / Output Port:

Basic EMC standard Immunity test level

IEC 61000-4-2 (ESD) ± 8 kV contact, ± 2 kV, ± 4 kV, ± 8 kV, ± 15 kV air

IEC 61000-4-4 (bursts) Only applicable for patient headsets, patient client
switch and speaker cables because cable length
might be > 3m.

IEC 61000-4-5 (surges) N/A; all SIP/SOP cables not directly connected to out-
door cables.

IEC 61000-4-6 (cond. RF) Only applicable for patient headsets, patient client
switch and speaker cables because cable length
might be > 3m.

B.3.2 Maximum permissible Cable Lengths of Accessories

Accessory, Transducer Maximum cable length

Power Supply (low voltage
side)

1,8 meters

USB cable 3 meters

REM probes

Client response switch

Air conductor headsets like
TDH39, DD45, DD450,
HDA300

Bone conductor headsets
like B71

2,5 meters (In combination
with extension cable
91.0704 prolongable up to
5,5 meters)

Insert headsets like EAR-3A,
ER-3C

2 meters (In combination with
extension cable 91.0704
prolongable up to 5,5 meters)

Free field calibration
microphone

3 meters

Table microphone (Talk back
microphone)

2,5 meters

Headset with microphone
(Monitor headset)

2,5 meters

Loudspeaker LS01 5 meters

RECD Speaker LS Mini 2,5 meters
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B.4 Pin Assignments Table
Primus Fitting Unit

Connector Air Conductor 1, 2, 3 Bone Conductor

Standard DIN Connector 8 pins

female

1. Ground 1. Output

2. Data Up/Down-
load

2. Data
Up/Download

3. Ground 3. Not Con-
nected

4. Optional Micro-
phone Input

4. Not Con-
nected

5. Plug Detect 5. Plug Detect

6. Left Channel Out-
put 6. Ground

7. Right Channel Out-
put

7. Not Con-
nected

8. Ground 8. Ground

Option*2*3 Primus Probe*1/Real Ear
Probe *2*3 Client Response

1. Secondary Micro-
phone Input 1. Ground 1. Not Connected

2. Data Up/Download 2. Data Up/Download 2. Logic Input (High/Low)

3. Ground 3. Ground 3. Not Connected

4. Primary Microphone
Input

4. Reference Microphone
Input, Left 4. +3.3 Vdc

5. Plug Detect 5. Reference Microphone
Input, Right 5. Plug Detect

6. Speaker Output,
positive

6. Probe Microphone Input,
Left 6. Control Clock

7. Speaker Output,
negative

7. Probe Microphone Input,
Right 7. Control Data

8. Ground 8. Ground 8. Ground

Primus Measure Solutions
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Connector Client*1*2/Demo*3

Headset

Free Field: Left/Right, Rear
and Sub/Mid*1*2

Free Field: Line out 1, Line out
2 Line out 3*3

3.5 mm TRS socket (mini-jack)
1. Left Channel
Output 1. Channel 1,3,5 Output

2. Right Channel
Output 2. Channel 2,4,6 Output

3. Ground 3. Ground

Monitor Headset Operator Micro-
phone Left

Operator Micro-
phone Right Talk Back Microphone

1. Left Channel
Output 1. Input 1. Input 1. Input

2. Right Channel
Output 2. Not Connected 2. Not Connected 2. Not Connected

3. Ground 3. Ground 3. Ground 3. Ground

Power supply: DC POWER JACK
1. +15 Vdc, 2A max
(Center)

2. Ground (Sleeve)

Primus Measure Solutions
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USB: Type B connector
1. 5 Vdc, 0.5A max

2. Data -

3. Data +

 4. Ground

SPDIF: Toslink optical
transmitter*3
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Speaker Output Right, Mid, Left

1. Positive

2. Negative

*1 This plug is only available in the PFU.

*2 This plug is only available in the PFU+.

*3 This plug is only available in the Primus Pro.
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Appendix C
C.1 Minimum Requirements (for Software Installation)
C.1.1 PC specifications for the connected operator PC

Minimum requirements Recommended requirements
Processor/clock speed 2 GHz 2 GHz (or higher) multi-core

System RAM 2 GB 4 GB or more

Free hard drive space 2 GB 2 GB

Operating System

Windows 8.1* (32-bit & 64-bit)

Windows 10 and Windows 10
Anniversary Update

Windows 8.1* (32-bit & 64-bit)

Windows 10 and Windows 10
Anniversary Update
Windows 11

Screen Resolution 1024 x 768 1280 x 1024

Graphics Card XVGA Dual monitor output

CD Drive Required if speech test CD´s
are used.

Required if speech test CD´s
are used.

Connection of Fitting
System to PC USB connector 2.0 or higher USB connector 2.0 or higher

Connection of HIT System
to PC (optional) USB connector 2.0** or higher USB connector 2.0** or higher

* Your OS must be up to date. All Windows updates must be installed.

** If a USB hub must be used in order to connect both units, a hub with power supply is
recommended.
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